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Introduction

This manual describes the use of PCB  design   software, its basic principles,  and  few

application circuits. 

The order of chapters follows the typical process from drawing a schematic  circuit

to a ready-to-use layout.

Electronics  have  an  exponentially  growing  influencing  our  lives.  Most  of  the

things used by an individual in day to day life include the contribution of electronics to

some extend. PCB’s have definitely contributed in a significant manner as a means of

interconnection of various electronic components. The field of PCB designing is a mutual

contribution  of  wide  range  of  various  other  fields.  For  example,  the  knowledge  of

mechanics, chemistry and electronics design, production and process management is an

essential  need for the construction of any particular PCB. The PCB is widely used in

fabrication of electronics as well as electrical  circuits since they provide a bae for the

connections amongst various components used in that particular circuit. 

The  PCB  based  circuits  are  highly  reliable  as  they  consist  of  fewer  inter-

connection wires. The testing and repairing of components are a lot easier in these (PCB

based) circuits. 

What is Printed circuit board (PCB)? 

Printed  circuit  boards  are  dielectric  substrates  with  metallic  circuitry  photo

chemically formed upon that substrate. There are thee major classifications: 

1- Single sided boards 

2- Double sided boards 

3- Multi layer boards 

Steps to PCB design using Express PCB/Orcad.

1. Design circuit using schematic entry package (Capture). 2. Generate
netlist for PCB package.

2. Import netlist into PCB package (LayoutPlus). 4. Place components,
route signals.

      3. Generate machining (Gerber) files for PCB plant.
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This document is a 'quick start', describing some of the most

commonly used operations for PCB design using Orcad. For more details

see on-line help and also the pdf manuals which are usually in Program

Files\Orcad\Document. These pdf files seem generally much more

comprehensive than the on-line help.

Schematic Design

• Use Capture to enter your design. Multiple schematic pages for same

design can be used.

• Tip: label nets you may want to locate at the pcb stage – net names

are carried through to the pcb design process.

• Select project in project window (as opposed to schematic window),

select Design Rule Check for Tools menu. Correct any errors in design.

•     Select project in project window, select Create Netlist from Tools menu.

     Choose Layout tab (to generate Layout compatible netlist), generate    

    netlist.   

    Choose units (English or metric) compatible with what you will use in  

    your pcb design.

PCB Layout

• Run LayoutPlus. Choose File/New.

• Select a “technology file” appropriate for your design. These are in

Program Files\Orcad\Layout_Plus\data and set defaults for things like

track spacing, hole sizes etc. Some examples:

1BET_ANY.TCH – allows single track between pins on standard DIP;

2BET_SMT.TCH – for surface mount and mixed smt/through hole

designs, 2 tracks between pins of standard DIP;

3BET_THR.TCH – through hole boards, up to 3 tracks between pins.

You're best using 1bet_any.tch if at all possible, since this is the
least demanding pcb technology.
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• Choose your netlist file (.mnl extension). If the units (English/metric)

are not the same you won't be able to load it. Just go back to Capture

and generate the netlist again with the right units.

• If some of your components chosen from the Orcad Capture libraries did not

have PCB footprints associated with them you will get “Cannot find

footprint for...” messages. If this happens, choose “link existing

footprint to component”. Browse footprint libraries to find the required

footprint (preview of footprint shown on screen). You can often guess

footprints from names. 

Examples:TM = through hole mounted (as opposed to surface mount)

BCON100T = block connector, 0.1” pitch, through hole

BLKCON.100/VH/TM1SQ/W.100/3 = block connector, 0.1” pitch,

vertical (as opposed to right angle), through hole, pin 1 square pad,

width 0.1”, 3 pins. Library DIP100T = dual in line packages, through

hole, 0.1” between pins.

If you can't find the right footprint then you'll need to make your

own. See “Creating a new Footprint” at the end of this document.

Draw Board Outline

 Click obstacle toolbar button.

 Somewhere in design, right click, select new.

 Right click again, select properties.

 Select: board outline, width = 50 (or as required), layer = global
layer, OK.

 Left click to place one corner of board, then right click on

successive corners. Draw a board the required size. Right click,

select finish when done (only need to do 3 corners, finish will

complete the outline). Notice that the dimensions are shown on

status bar at bottom of screen as you draw the board – can be
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helpful for creating particular board size. (You can do all this

later, after you've placed and routed everything if you prefer.)

Choose Layers

• Use spreadsheet toolbar button to see the Layers spreadsheet.

• Enable only the layers you want for routing, set other layers to unused

(double click on the spreadsheet entry, select unused routing). For a

single sided board you probably want only the “bottom” layer, for

double sided you probably want “top” and “bottom”, for a 4 layer

board you probably want these plus power and ground plane layers. Tip:

you can select multiple layers using click with ctrl key, then right click,

select properties, then set/clear unused routing to simultaneously enable

or disable several layers.

Place Components

• Select “component” tool from toolbar, click on required component and

drag it where you want. Right click to see some options, including

rotate.

• Auto/place board will attempt to place components automatically for

you within board outline. You may want to move components manually

as well.

Track Thickness

• To change, select “nets” spreadsheet, double click on required net to

set its properties. Net names are inherited from your schematic

diagram – explicitly naming nets helps you identify them in the PCB

design. For a simple through hole board you probably want about

20mil tracks. For surface mount boards you probably want 10 or 12

mil tracks. Our pcb plant will make 5 mil tracks if you really need

them, but there's an increased risk of part of the track being lost in the

etching process. 10 or 12 mil can be reliably made. You may want to

4



CMREC ECE-DEPT                       ATL PCB Design-LAB

make power and ground tracks thicker.

Routing

• Automatic routing is ok, but you can manually route as well (use toolbar

buttons).

• Make sure you've set the track thicknesses as you want before routing

(see above).

• You may want to route power and ground first, especially if it's a 1 or 2

layer board. Use the nets spreadsheet to enable/disable those nets you

want to route at any one time. Tip: select Routing Enabled column, right

click, disable to disable all nets, then enable the ones you want.

• You may want to give priority to critical nets (those that need shortest

paths), to optimally route those. Priority can be selected from the

“nets” spreadsheet for each net.

• To automatically route, select Tools, auto, route board. To put

everything back to the rat's nest net, tools/auto/unroute board.

• You can auto route just one component by selectingautoroute/component
then click on a pin on that component.

• After an autoroute/board is completed, orcad thinks it's finished, and if

you run it again (eg to route some more signals that were disabled the

first time) it says all sweeps done or disabled and won't run again. To

run autoroute again you have to remove "done" from all autoroute

passes. Click the spreadsheet toolbar button and select strategy/route

pass. Select the whole "enable" colum, right click, select properties.

Remove the "done" tick and click OK. Close the spreadsheet and you can

now run the autorouter again.

Copper Pour

• Copper pour fills selected unused board area with copper. This allows

creation of large ground (and/or power) areas which improves noise
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properties. Also reduces amount of copper that needs to be etched off

the board by manufacturing process.

• Tip: don't do this until you've finished placement and

routing. 

• Select required layer (eg TOP or BOTTOM).

• Select obstacle tool (toolbar button), right click in design, select new.

• Right click again, select properties

• Select copper pour, net = GND (or as required), OK. (This example 

would connect copper pour to the GND net.)

• Draw (by left click and drag) the outline for the copper fill.

• Repeat as required for other copper pour areas and/or layers.

• If you want to delete it, select it by using obstacle tool then ctrl left 

click on the pour. Then press the delete key.

Set Datum (origin)

• From Tool menu select dimension/move datum.

• Left click at the bottom LH corner of your board to set the origin. 

(Exact placing doesn't matter.)

Generate Machining Files (Gerber files)

• The machining files required to manufacture the PCB are generated by 

the “post processor”. From options menu choose “Post Processing”. In 

the spreadsheet, select the layers you need to manufacture. You need at 

least the routing layers you have used (eg top, bottom) and the drill 

information.

• Choose Auto/Post Process to generate the files. The files generated by 

the post processor are the only ones needed for the PCB plant to make 

the board.

Tips

 Use the colour toolbar button, click on a colour box and press the –
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key to toggle its visibility. With copper pour in place it can be hard

to see what you've got.

 Silk Screen - to see it, you need to add it to the colours table. Use

Colours tool, right click, new. Select layer SST (silk screen top), rule

= default, OK.

 Use manual place (auto place doesn't optimise placement for noise

considerations).

 When placing, set critical nets (eg op amp inputs) to a distinctive

colour (via nets spreadsheet) so you can easily see them to optimise

placement.

 Place connectors first – they need to be in a convenient place (eg near

the edge).

 Some components have multiple parts within one package. Place an

additional part in the schematic, choosing, for example, the B part.
The “annotate design” tool will combine them into one package
(same component identifier). Don't forget to connect unused inputs to
appropriate places (eg power, ground) in the schematic, particularly
for digital circuits.

 You can go back and change your schematic. Then, when you generate

the netlist again, be sure to select the box “Run ECO to Layout”

(Engineering 

Change Order). The PCB will be appropriately changed (you may 

need to then tidy things up).

To select an obstacle (eg board outline or copper pour) select the 

obstacle tool (toolbar button). Hold ctrl key down and left click on obstacle 

to select it (becomes highlighted – usually white). Or, click on corner of 

obstacle and drag as required. Or, select obstacle by drawing a box (with 

obstacle tool selected) which includes some part of the object.

Make sure you do a save fairly often. You can save to a different file 

name if you want, then you have a partial pcb design you can go back to if 

you change your mind how to do things. Do a save before trying anything 
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daring. Then if it doesn't work out you can just exit without saving and 

start again with your previously saved design. Beware: the "undo" option is 

only occasionally helpful.

The on-line manuals are ok, but more detailed information is in the 

pdf files contained in the Orcad Family folder (eg information on 

technology files, strategy files and many more complex operations than 

those mentioned here).

Creating a New Footprint

An easy way to create a new footprint is to find an existing one that's 

similar, edit it and save it with a new name.

• Start Layout+ and choose tools/library manager.

• The list of libraries is displayed in the top part of the window. Click 

on one you think may be useful.

• The list of footprints in that library is now shown in the bottom 

window. If you click on a footprint it is displayed in the window on 

the right.

• Browse to a footprint that's close to what you want. (eg Right number of 

pins but wrong width, or vice versa.)

• To move a pin, choose pin tool, click on pin, move cursor to where you 

want it. (You can also use the arrow keys.) The coordinates and distance 

moved are shown in the status bar at the bottom.

• Another, possibly easier way to move a pin to the right place is to 

edit its properties in the footprints spreadsheet. You can just type in 

the required x,y coordinate of the pin here. You can also take a copy 

of a pin (ctrl C) if you need to add pins.

• To move text use the text tool, click on the text and drag it to where 

you want.
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• To change the place outline and detail, select them using the obstacle 

tool and either delete (delete key) or drag to where you want. If you 

delete and redraw, make sure it's the right obstacle type (right click, 

properties). The place outline shows the board space taken – other 

footprints can't be placed within this outline.

• When you want to save, do a “save as” (don't overwrite the original library
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Quick Start Guide To ExpressPCB
There  are  two parts  to  ExpressPCB, our  CAD software  and our  board manufacturing

service.   Our  CAD  software  includes  ExpressSCH  for  drawing  schematics  and

ExpressPCB for designing circuit boards.  We also provide a low cost, high quality and

fast source for having your boards made.  Here is how it works:

1. We recommend that you begin by drawing a schematic using ExpressSCH.

2.  Next,  use  the  ExpressPCB program to  lay  out  your  PC  board.   If  you  link  your

schematic to 

    ExpressPCB, it will guide you through the wiring process.

3. When your layout is complete, determine the exact cost to have boards made with the  

    Compute Board Cost command.

4. To order the boards, enter your name, address and billing information into ExpressPCB

and  

     press the Send button within the Order Boards Via The Internet dialog box.

5. In a few business days (typically 2 or 3) an overnight courier will deliver your PC

boards.

Designing a PCB
ExpressPCB  is  a  very  easy  to  use

Windows  application  for  laying  out

printed circuit boards.  While not required,

we suggest that you draw a schematic for

your  circuit  using  the  ExpressSCH

program.   By  linking  your  schematic,

ExpressPCB  will  guide  you  by

highlighting  the  pins  that  should  be

connected together with traces.

Note:  ExpressPCB defaults to coordinates

in inches.  The exact position of the mouse

is displayed on the status line.  
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The Side Toolbar
The toolbar  along the left  side of the ExpressPCB main window is used to select the

editing  modes,  such as  place  component  and place  trace.   These  are  the  side  toolbar

buttons:

At

the
bottom of the side toolbar are 4 additional buttons that toggle on and off features of the
display:

The Top Toolbar

When you click on a side toolbar button, additional buttons are added to the top toolbar,

specific to the function selected.  These buttons are always displayed on top:
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Beginning a New Layout

1. Begin a new layout by running ExpressPCB.  If you are designing a four-layer board,  

   select Board properties from the Layout menu and check the 4-Layer option.  

2. In the main window, the yellow rectangle defines the perimeter of the PC board.  Set   

    the size of your board by moving three of its four corners (the upper left corner is fixed  

    at 0,0).  Move the corners by dragging them with the mouse, or by double-clicking them

     and entering coordinates.  Additional corners can be added to the perimeter to change  

    its shape (see ExpressPCB:  Changing the Board Perimeter).

3. Select the size of the Default via.  In some cases as you place traces, ExpressPCB  

     inserts via (plated-through holes) when a trace changes between the upper and lower    

    layers.  When inserted, these via pads are always visible.  Set the Default via in the  

     Board properties dialog box.

4. If you have drawn a schematic of your circuit using ExpressSCH, link the schematic file

    to your circuit board layout using the Link schematic to PCB command found under the

    File menu.

5. Finally, give your board a name by selecting Save As from the File menu.

Zooming and Panning

The  easiest  way to  move around  your  layout  is  with  the  scroll  wheel  on  the  mouse.

Turning the wheel zooms in and out.  Pressing the wheel and dragging the mouse pans.

The Grid

The Snap-to-grid is  an invisible  grid that

helps  you  align  traces  and  components.

With the Snap-to-grid on, you will notice

that as you place objects, they gravitate to

a grid boundary.  The Snap-to-grid spacing

is set from the Options dialog box or from

the  Snap  listbox  located  on  the  lower

statusbar.  To toggle the Snap-to-grid on or off, press the G key or click .
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Placing Components

The  easiest  way to  place  components  in  your  board  layout  is  to  use  the  Component

Manager.  

Tip:  Use the Find button to search for a PCB footprint by its name.

To place a component:

1.Click the button located on the top toolbar to display the Component    

   Manager.

2. Select one of these categories:·  Library components  -  Components that are included  

    with the program·  Custom components  -  Components that you have drawn·  Favorite  

   components  - Components or symbols that you have book-marked

3. From the list box, choose the item to insert then select the component's orientation

(rotated up, left, down, or right) by clicking one of these buttons:

4. Press the Insert component into PCB  button, then drag the component to the desired      

   location.

5. Assign the component's Part ID (such as R1 or U2).  To do this, select    then

double-click on the component to display its Component properties dialog box.

Note:  Setting the Part ID is required if you  link your schematic and PCB.  In order to

mate a schematic component with one on the board layout, the Part IDs must match. 

Placing Pads
Individual pads are used both to build new components and as via.  To insert a pad:

1.From the side toolbar, select   or press the P shortcut key.

2.Select a pad size from the drop down list box on the top toolbar.  There are several pad   

  types: round,  square, surface mount and via.  Vias are used to pass traces between  

   layers.  Regular pads differ from via pads in that ExpressPCB may eliminate a via if the  

  traces connecting to it are all on the same layer.

Tip:  If you cannot find a pad the size you need, a custom pad is easily created.  See:   

       ExpressPCB:  Making Custom Pads

3.To place the pad, click on your layout at the desired location.
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Placing Traces

These are the steps to add traces to your layout.  If you have drawn a schematic for your

circuit, be sure to read the section Linking the Schematic and PCB before you begin.

1. From the side toolbar, select  or press the T shortcut key.

2. Select the trace width from the drop down list box on the top toolbar:  A width of 0.010"

is a good default for digital and analog signals.  For power lines, use traces 0.05" or wider.

3. Select the layer by clicking   or by pressing the L shortcut key.

4. Move the mouse to the trace's first end point and click.  Drag the trace to the second end

point, then  click again.  Continue placing trace segments (use the L key to change layers)

until you have reached the final end point.

 Tip:  Keep an eye on the statusbar when connecting traces to components. It will

display the pin and part number to which the trace is connected.

5.  As you drag the  trace,  the L key changes  layers,  the Del  key deletes  the previous

segment, the + and – keys zoom in and out, the G key toggles the snap-to-grid on and off.

The Spacebar sets the trace, and the Esc key cancels it.

6. To complete the operation, press the Spacebar or click right.

Working with Traces

Traces themselves cannot be moved.  The path of a trace is determined by

the straight line between its two connections.  Therefore, to move a trace,

you  need  to  connect  it  to  something  different  or  to  move  what  it  is

connected to.Corners in traces allow them to bend.  They are displayed as

small square blocks at the ends of traces.  A trace with two corners is shown

here.  In your final PC board layout, the corners will not be included.

Corners can be dragged, inserted or deleted to change the trace's path.  To insert a corner,

select   then click   to choose the layer on which the corner will be placed.

Next click on the trace at the point where you want to insert the corner.

To disconnect a trace and reconnect it elsewhere, select   from the side toolbar.  Next,

click on the trace near the point you want to disconnect, then drag the trace to a new pin.

14



CMREC ECE-DEPT                       ATL PCB Design-LAB

Placing Filled Planes

Filled Planes are used to add ground or power planes to a circuit, usually on

double-sided boards.  They can be placed on the top or bottom layers.  The

perimeter  can  have  the  shape  of  any  polygon  and  the  interior  is

automatically insulated from traces and pads.

Note:  The Filled Plane feature is not supported in Windows 95, 98 or ME.

To place a Filled Plane, select , then on the top toolbar choose the Draw filled plane

option,  along with the layer.  Next use the mouse to draw the perimeter.  Do this  by

clicking the left mouse button at each corner, then clicking right after you have placed the

last corner.Connect a pad to a plane by right clicking on the pad.  In the popup menu,

select one of the Top layer pad shape or Bottom layer pad shape options.

Important:  After creating a plane, you will want to inspect it for possible problems.

Learn how here:  ExpressPCB: Placing Power and Ground Planes

Tip:  After adding a Filled Plane, you may want to lock or hide it using the Options

dialog.  If planes are hidden, they still will be included when the boards are manufactured.

Designing a Four-Layer PCB

Begin a four-layer design by selecting the 4-Layer option in the Board properties dialog

box. This adds two inner layers to your layout, a Power plane and a Ground plane. 

Any through-hole pad in a layout can be connected to either the Power or

Ground internal planes by right clicking on the pad.  In the popup menu,

select one of the Power inner layer pad or Ground inner layer pad options.

Connections  to  the  Power  plane  are  displayed  with  a  +  over  the  pad.

Ground plane connections are marked with a - symbol.
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To look at the actual inner layer planes, select View Power layer or View

Ground layer in the Options dialog box.  This example shows pins 1, 3,

and 8 connected to the Power plane. The other pads are isolated.You

will notice that pins 1 and 8 are connected with Thermal pads, while pin

3 is connected with a Solid pad.  Typically Thermals are used with pads

connecting to  a plane because they improve the solderability of the pad, reducing the

chance of a "cold solder joint".

When viewing inner layers, you can draw split planes and keep out areas.

Setting Properties of an Item

All the items in your layout have properties.  For example, the properties of a pad include

the pad type and its XY coordinates.

To view or change the properties of an item, select   then double click on the item.

Copying, Deleting and Moving Items

ExpressPCB uses standard Edit commands for Copy, Cut and Paste.  To copy an item or

several items, first select them.  From the Edit menu choose Copy, then from the Edit

menu choose Paste.

Deleting items from your layout is as easy as selecting them and pressing the Del key.

There  are  three  ways  most  items  can  be  moved.   Typically, items  can  be  moved  by

selecting and dragging them.  They can also be moved with the arrow keys by selecting

them and then pressing Ctrl-right, Ctrl-left, Ctrl-up or Ctrl-down.  Alternately, an item can

be moved by changing the coordinates set in its properties dialog box.

Tip:  To copy a group of items from one layout file to another, select and copy the items

of interest into the clipboard.  Load the second file into ExpressPCB and paste.  It is not

possible to copy items between two programs running at the same time.

Changing the Layer of Items
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To move traces, rectangles and text between the top and bottom copper layers, select them

with the mouse then click  to move the selection to the top layer; click  to move it to the

bottom.

Linking the Schematic and PCB

Running the traces from component to component is simplified if the schematic and PCB 

are linked.  Embedded in Express SCH schematic files are wiring lists (called Net Lists).  

When linked, the Express PCB program highlights which pins need to be wired together.

Before linking your schematic, check it for errors.  Run the command Check schematic for

net list errors from the File menu of Express SCH.  If errors are reported, correct them,

then save the schematic file.  For more information, see:  Express SCH: Checking the

Schematic for Errors

 Next,  for every part  referenced in your schematic,  you need to  insert  the component

footprint for that part in your PCB design.  Also, the Part ID values for each footprint must

be set.  To learn how to insert the footprints and set the IDs, see:  Placing Components

Note:  The Part IDs are used to match a schematic component with its PCB footprints

when highlighting a net.  (i.e. a Part ID of R12 in the schematic will be matched with a

PCB footprint that also has the Part ID set to R12).  

Now link your schematic and PCB files.  From the File menu of the ExpressPCB program,

select the command Link schematic to PCB.

Once linked,  ExpressPCB can show you which pins  should be connected  together  by

highlighting them in blue.

To highlight a "Net", select   from the side toolbar, then

click on one of the pads of a component.  This highlights the

other pads that should be wired to the pad you've selected.  If

the schematic has nothing connected to that pin, then no pads

are highlighted.
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You can step through all of the "Nets", from first to last, to visually inspect your PCB for

missing connections.  This is done by selecting  and then clicking on  to

navigate through all of the nets:

Tip:  The ExpressPCB program reloads the linked schematic file every time the .PCB file

is opened.  If you run ExpressSCH and ExpressPCB at the same time, you can update the

link  by first  saving  the  schematic  within  ExpressSCH,  then  selecting  Refresh  link  to

schematic from the File menu in ExpressPCB.

Making Custom PCB Components

Express PCB includes many components that you can use to create your PCB.  However if

you need a footprint not found in our library, you can easily build your own.  Here is how:

1. First add the pads by selecting   and choosing a pad type on the top

toolbar.  Carefully position the pads with the correct spacing.  It may be

helpful to change the Snap-to-grid spacing in the Options dialog.

Tip:  If you cannot find a pad the size you need, create a custom pad.  See:
ExpressPCB:  Making Custom Pads

2. Assign each pad a Pin number.  This must be done if you link your PCB

to its schematic.  Assign pin numbers by selecting   and then double

clicking on each pad to display its Pad Properties dialog box.  In the Pin

number field, enter the pin number.

3. Draw the component outline for the new part on the silkscreen layer.

Draw straight lines by selecting  or circles and arcs using .  Be

sure to select the silkscreen layer before drawing the outline by clicking

 .  The recommended line width for drawing component outlines is 0.012".

4. Group  everything  together  to  combine  it  into  a  single  component  as  follows.

Select all of the objects in your new part by clicking  and then dragging the

mouse to enclose them.  From the Component menu, choose the command Group
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to make PCB component.   Next,  double click the new component to

assign its Part ID (i.e. U12).

5. Save the component to add it to the Custom components list.  Do this by

selecting  the  part  with  the  mouse  and  then  choosing  Save  custom

component from the Component menu.

FYI:  ExpressPCB stores every component in its own file.  These files have the .P

extension and are saved in the directories:

 Program Files\ExpressPCB\PCBComponents_Library·  
 Program Files\ExpressPCB\PCBComponents_Custom

Modifying Library Components

Sometimes it is easiest to build a new component by starting with one from our library, for

example to change the pad sizes.  This is done by first inserting the library component into

your layout.  Next select it  with the mouse then choose the Ungroup PCB component

command from the Component menu.  Now select only the pads and double click on one.

In the Pads Properties dialog, change the pad size.  Finally, group the component back

together as described above to create the new part.  Your changes will NOT affect the

original part in the ExpressPCB library.

Having PC Boards Made

When you have completed your layout, the next step is to have the boards made.  Before

ordering, you can determine the cost using the Compute Board Cost command from the

Layout menu.

To order your boards, connect your computer to the Internet then select the Order Boards

Via The Internet command from the Layout menu.  Fill in the forms that follow and press

the  SEND  button.   Your  order  is  sent  to  ExpressPCB  for  manufacturing.For  more

information, see the online help section Having PC Boards Made.

Circuit Board Design Tips

The engineers at ExpressPCB have assembled a few general rules of thumb that can help

the beginner design their first printed circuit board. These tips are not specific to using our
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CAD software,  but  instead  provide  an  overview to  help  explain  how to  position  the

components on the board and how to wire them together with traces.

Placing Components:

Generally, it is best to place parts only on the top side of the board.When placing

components, make sure that the snap-to grid is turned on. Usually, a value of 0.025" for

the snap grid is best for this job.First place all the components that need to be in specific

locations. This includes connectors, switches, LEDs, mounting holes, heat sinks or any

other  item  that  mounts  to  an  external  location.Give  careful  thought  when  placing

component to minimize trace lengths. Put parts next to each other that connect to each

other. Doing a good job here will make laying the traces much easier.Arrange ICs in only

one or two orientations: up or down, and, right or left. Align each IC so that pin one is in

the same place for each orientation, usually on the top or left sides.Position polarized parts

(i.e. diodes, and electrolytic caps) with the positive leads all having the same orientation.

Also use a square pad to mark the positive leads of these components.You will save a lot

of time by leaving generous space between ICs for traces. Frequently the beginner runs

out of room when routing traces. Leave 0.350" - 0.500" between ICs, for large ICs allow

even more.Parts not found in the component library can be made by placing a series of

individual  pads  and then  grouping them together. Place  one  pad for  each lead  of  the

component. It is very important to measure the pin spacing and pin diameters as accurately

as possible. Typically, dial or digital calipers are used for this job.After placing all the

components, print out a copy of the layout. Place each component on top of the layout.

Check  to  insure  that  you  have  allowed  enough  space  for  every  part  to  rest  without

touching each other.

Placing Power and Ground Traces:

After the components are placed, the next step is to lay the power and ground

traces. It is essential when working with ICs to have solid power and ground lines, using

wide traces that connect to common rails for each supply. It is very important to avoid

snaking or daisy chaining the power lines from part-to-part.One common configuration is

shown below. The bottom layer of the PC board includes a "filled" ground plane.  Large

traces feeding from a single rail are used for the positive supply.
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Placing Signal Traces:

When placing traces, it  is always a good practice to make them as short and direct as

possible.Use vias (also called feed-through holes) to move signals from one layer to the

other. A via is a pad with a plated-through hole.Generally, the best strategy is to layout a

board with vertical traces on one side and horizontal traces on the other. Add via where

needed to connect a horizontal trace to a vertical trace on the opposite side.A good trace

width for low current digital  and analog signals is  0.010".Traces that carry significant

current should be wider than signal traces. The table below gives rough guidelines of how

wide to make a trace for a given amount of current.

0.010"  0.3 Amps
0.015" 0.4 Amps
0.020" 0.7 Amps
0.025" 1.0 Amps
0.050" 2.0 Amps
0.100" 4.0 Amps
0.150" 6.0 Amps

When placing a trace, it is very important to think about the space between the

trace and any adjacent traces or pads. You want to make sure that there is a minimum gap

of 0.007" between items, 0.010" is better. Leaving less blank space runs the risk of a short

developing in the board manufacturing process. It is also necessary to leave larger gaps

when working with high voltage.When routing traces, it is best to have the snap-to-grid

turned on. Setting the snap grid spacing to 0.050" often works well. Changing to a value of

0.025" can be helpful when trying to work as densely as possible. Turning off the snap

feature may be necessary when connecting to parts that have unusual pin spacing.It is a

common practice to restrict the direction that traces run to horizontal, vertical, or at 45

degree angles.When placing narrow traces, 0.015" or less, avoid sharp right angle turns.

The problem here is that in the board manufacturing process, the outside corner can be

etched a little more narrow. The solution is to use two 45 degree bends with a short leg in

between.It is a good idea to place text on the top layer of your board, such as a product or

company name. Text on the top layer can be helpful to insure that there is no confusion as

to which layer is which when the board is manufactured. 

Checking Your Work:
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After all the traces are placed, it is best to double check the routing of every signal

to verify that nothing is missing or incorrectly wired. Do this by running through your

schematic, one wire at a time. Carefully follow the path of each trace on your PC layout to

verify that it is the same as on your schematic. After each trace is confirmed, mark that

signal  on  the  schematic  with  a  yellow  highlighter.Inspect  your  layout,  both  top  and

bottom, to insure that the gap between every item (pad to pad, pad to trace, trace to trace)

is 0.007" or greater. Use the Pad Information tool to determine the diameters of pads that

make up a component. Check for missing vias. Express PCB will automatically insert a

via when changing layers as a series of traces are placed. Users often forget that via are

not automatically inserted otherwise. For example, when beginning a new trace, a via is

never inserted. An easy way to check for missing via is to first print the top layer, then

print the bottom. Visually inspect each side for traces that don't connect to anything. When

a missing via is found, insert one. Do this by clicking on the Pad in the side toolbar, select

a via (0.056" round via is often a good choice) from the drop down listbox, and click on

the layout where the via is missing. Check for traces that cross each other. This is easily

done by inspecting a printout of each layer. Metal components such as heat sinks, crystals,

switches, batteries and connectors can cause shorts if they are placed over traces on the top

layer. Inspect for these shorts by placing all the metal components on a printout of the top

layer. Then look for traces that run below the metal components.
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1. Street light circuit.

Description.

The circuit diagram present here is that of a street light that  automatically switches ON
when the night falls and turns OFF when the sun rises. In fact you can this circuit for
implementing any type of automatic night light.

The circuit uses a Light Dependent Resistor (LDR) to sense the light .When there is light
the resistance of LDR will be low. So the voltage drop across POT R2 will be high. This
keeps the transistor Q1 ON. The collector of Q1(BC107) is coupled to base of Q2(SL100).
So Q2 will be OFF and so do the relay. The bulb will remain OFF.

When night falls the resistance of LDR increases to make the voltage across the POT R2
to decrease below 0.6V. This makes transistor Q1 OFF which in turn makes Q2 ON. The
relay will be energized and the bulb will glow.

Circuit diagram with Parts list. 
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Notes. 

 POT R2 can be used to adjust the sensitivity of the circuit.

 You can use bulb of any wattage, provided that relay should have the sufficient 
rating.

 The circuit can be powered from a regulated 9V DC power supply.

 Click Here! to get the power supply circuit for this project.

 The relay K1 can be a 9V SPDT relay

o 2.Regulated Power Supply(5V &12V) 

Circuit diagram:

This is a small +5V regulated  power supply circuit. In that case here we used
7805 and 7812 Voltage Regulator IC’s. 7805 is a +5 Volt regulator IC and 7812 is a
+12 Volt regulator IC from 78xx chips family. The circuit has internal current
limiting and thermal protection capacity. A 12V 2A steps down transformer is
used to covert 230V to 12V from mains. Here used a bridge rectifier made by
four  1N 4007 diode to convert AC-DC . 470uF 50v as C1 is used for filtering. This
circuit is very easy to build. For good performance recommended input voltage
8V-18V. If  over 400mA current is needed at output then use a heat sink with the
7805 IC. 
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3. Transistor intercom circuit.
Description.

Here is a simple but effective intercom circuit that is based fully on transistors. The circuit
is based on a three stage RC coupled  amplifier. When the pushbutton S2 is pressed, the

amplifier  circuit  wired  around  T1  & T2  becomes  an  astable  multivibrator  and  starts
producing the ringing signals. These ringing signals will be amplified by the transistor T3
to drive the speaker. When the push button S2 is released the circuit will behave as an
ordinary amplifier and you can talk to the other side through it.

To construct a two way intercom, make two identical copies of the circuit given below and
connect it according to the given connection diagram. The stand by current consumption
of this circuit is around 20mA.

Connection diagram. 
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 4. Night
security
light

Description.

 Here  is  a
simple circuit switches on a light around 2 hours after midnight, the time at which most of
the robberies taking place.

This simple circuit is build around a CMOS IC 4060 to obtain the required timing. During
day time the LDR has low resistance and keeps the pin 12 of the IC1 high, preventing the
IC1 from oscillating. When it is dark the LDR resistance becomes high and the pin 12 of
IC1 becomes low and the IC  starts oscillating, which indicated by the flashing of LED
D3.The values of the timing components R1, R2, C4 are so selected that the out put pin3
of IC1 goes high after 8 hours. That means the high output drives the triac to switch on the
lamp around 2’O clock. At morning, the LDR resistance drops and the pin 12 of IC1 goes
high  and stops  the  oscillation,  making the  lamp OFF. The  switch  S1 can  be  used  to
manually ON the lamp. The capacitor C2 prevents false triggering.
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Notes.

  Assemble the circuit on a good quality PCB or common board.

 The LDR can be general purpose LDR.

 The light sensitivity can be adjusted using the preset R6.

 The IC1 must be mounted on an IC holder.

5. Lamp flasher circuit

Description.

This simple circuit that can be used to flash incandescent lamps up to 10W power 
rating.The circuit is ideal for making flashing beacons on automobiles  and other 
applications like that.The circuit is nothing but  an astable multi vibrator based on Q1&Q2
( BC557&BD139).The capacitor C1 is the main timing element which determines the 
flashing rate  of the circuit.The switch S1 can be used as an ON/OFF switch.

Circuit diagram 
with Parts list.
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Notes. 

 Power the circuit from a 12 V battery or 12V DC power supply.

 Assemble the circuit on a goood quality PCB or common board.

 A 12 v , 10W incandescent lamp can be used as the load.

 All capacitors must be rated 15V

6. Door bell circuit using NE555
Description.

The main part of this doorbell circuit are two NE555 timer ICs.When some one presses 
switch S1 momentarily, the loud speaker sounds a bell tone as long as the time period of 
the monostable multivibrator built around IC1.

When the switch S1 pressed, IC1 is triggered at its pin 2 and output pin 3 goes high for a 
time period previously set by the values of POT R4 and POT R5.When the output ofIC1 
goes high it resets IC2 and it starts to oscillate to make a bell sound through the 
speaker.The IC2 is configured as an astable multivibrator whose oscillation frequency can 
be varied with the help of POT R5.By adjusting the values of R4 & R5, modifications on 
the tone are possible.

Circuit diagram with Parts list.
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Notes.

 The circuit has to assembled on a good quality PCB or common board.

 The IC1 & IC2 has to be mounted on IC holders.

 Power the circuit from a 9V battery or 9V DC power supply.

 Switch S1 is push button switch.

7. Long duration timer circuit.

Description. 

This timer circuit can be used to switch OFF a particular device after around 35 minutes.
The circuit can be used to switch OFF devices like radio, TV, fan, pump etc after a preset
time of 35 minutes. Such a circuit can surely save a lot of power. The circuit is based on
quad 2 input CMOS IC 4011 (U1).The resistor R1 and capacitor C1 produces the required
long time delay. When pushbutton switch S2 is pressed, capacitor C1 discharges and input
of the four NAND gates are pulled to zero. The four shorted outputs of U1 go high and
activate  the  transistor  Q1 to drive the  relay. The appliance  connected  via  the relay is
switched ON. When S2 is released the C1  starts charging and when the voltage at  its
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positive pin becomes equal to ½ the supply voltage the outputs of U1 becomes zero and
the  transistor  is  switched  OFF.  This  makes  the  relay  deactivated  and  the  appliance
connected via the relay is turned OFF. The timer can be made to stop when required by
pressing switch S1.

 Circuit diagram with Parts list.

8. Water level alarm circuit

Description. 

Here is a simple water level alarm circuit using 555 timer that will produce an  audible
alarm when the water level reaches  a preset level.The circuit can be powered of a  3V
battery and is very handy to use. 

The circuit is based on an astablemultivibrator wired around IC1 (NE 555).The operating
frequency of the astable multivibrator here will depend on capacitor C1, resistances R1,R2
and the resistance across the probes A&B. When there is no water up to the probes, they
will be open and so the multivibrator will not produce oscillations and the buzzer will not
beep. When there is water up to the level of probes, some current will pass through the
water, the circuit will be closed to some extend, and the IC will start producing oscillations
in a frequency  proportional to the value of C1,R1,R2 and the resistance of water across
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the probes. The buzzer will beep to indicate the presence of water up to the level of the
sensing
prob.
Circuit

Diagram with Parts list.

Notes.

 The circuit can be powered of a 3V battery.

 Assemble the circuit on a good quality PCB or common board.

 The probes can be made of two insulated copper Aluminiun wires.

 Place the probes at the position where you have to sense the level.

9. Mobile incoming call indicator
Description.

This circuit can be used to escape from the nuisance of mobile phone rings when you are
at home. This circuit will give a visual indication if placed near a mobile phone even if the
ringer is deactivated.

When a call is coming to the mobile phone, the transmitter inside it becomes activated.
The  frequency  of  the  transmitter  is  around  900MHz.The  coil  L1  picks  up  these
oscillations  by induction and feds  it  to  the base of  Q1.  This  makes  the transistor  Q1
activated. Since the Collector of Q1 is connected to the pin 2 of IC1 (NE555) , the IC1 is
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triggered to make the LED connected at  its output pin (pin 3) to blink. The blinking of the
LED is the indication of incoming call.

Notes. 

 The coil L1 can be made by making 150 turns of 36 SWG enameled copper wire
on a 5mm dia plastic  former. Or you can purchase a  10 uH coil  from shop if
available.

 The circuit can be powered from a 6V battery.

 Assemble the circuit on a good quality PCB.

 C1 & C3 are to be polyester  capacitors.

 The electrolytic capacitor C2 must be rated 10V.

10. Strip LED Lamp Circuit

Strip LEDs are available in different colours powered by direct current (DC) source. These
LEDs are available as surface mount devices with current limiting resistors. Usually there
are 300 LEDs in a 5-metre strip. The strip can be cut into pieces so that the bits having
three or four LEDs can be used with 12V DC source. The circuit given here uses the strip
LEDs to  make an  automatic  white  LED lighting  source.  The circuit  is  powered by a
capacitor power supply connected to AC mains. Capacitor C1 drops the 230V AC, which
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is further rectified by the bridge rectifier module and is made ripple-free by C2. Zener
diode (ZD1) provides 12V DC to the comparator circuit.

Resistor R1 is important in the power supply as it provides discharge path to the voltage
stored in capacitor C1 after the circuit is unplugged from mains. The automatic working of
the circuit is based on the light-sensing property of the light-dependent resistor (LDR).
Operational amplifier CA3140 (IC1) is used as a comparator with two potential dividers in
its inverting and non-inverting inputs. LDR1 and resistor R3 form one potential divider
that  provides  a  variable  voltage  at  the  inverting  input  pin  2 of  IC1.  Second potential
divider comprises resistors R4 and R5, which provide half of the supply voltage (6V) to
the non-inverting pin 3 of IC1. The output of IC1 depends on voltage level at inverting
input pin 2 of IC1 as explained below.

In daylight, LDR1 has low resistance and the voltage at inverting input (pin 2) of IC1 is
more than that of non-inverting input (pin 3). This makes IC1 output low, which drives
transistor T1 into cut-off condition and strip LEDs do not glow. However, at night the light
incident on LDR1 is low and its resistance is high. The voltage at inverting input of the
comparator decreases, making it lower than the voltage at non-inverting input. This makes
IC1 output high. Transistor T1 goes into saturation, thus connecting cathodes of LEDs to
ground. All the LEDs in the strip turn on and remain that way till morning.

Assemble the circuit on a general-purpose PCB and enclose it in a suitable shock-proof
case. Strip LEDs are available in ribbon-shaped form. Use 5cm bits (two bits) having three
LEDs each. The strip can be cut at supply-contact points. Strip LEDs are arranged on a
flexible belt with double-sided adhesive on the back side, so it can be glued to any surface.
Connect the LED strip in the circuit with correct polarity. EFY note. Since the circuit uses
230V AC, there is a risk of electrical shock. Do not touch or troubleshoot when the circuit
is plugged in. Before connecting the circuit to the power supply section, test it using 12V
DC from a battery or DC power supply.
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